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The software and any related written materials are copyrighted. 
Unauthorized copying of the written materials of the software is expressly 
forbidden. The licensee or any person renting or using the software and 
written materials by other terms may be held legally responsible for any 
copyright infringement that is caused or encouraged by failure to abide by 
terms of this license. The licensee may make copies of the software solely 
for backup purposes. 
 
In no event may the licensee transfer, assign, or otherwise dispose of the 
software except with the written permission of the licensor. 
 
In no event will the licensor be held responsible for any damages arising 
out of the use or inability to use this software. 
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1 Introduction 
________________________________________________ 
 
 
GroundVision™ is the data acquisition software dedicated to  
MALÅ GPR Systems. GroundVision can acquire data from 
MALÅ ProEx or X3M systems. As a Windows™ based 
software; GroundVision gives you an easy-to-use user 
interface, file management, printing and other key features. 
Each measurement and associated settings are stored in files. 
Filtering can be performed with the measurement or as post-
processing. GroundVision software supports both GPS logging 
and multiple markers during measurement. All radargrams can 
be printed as such, or post processed by further software. 
 

             
 
 
System requirements: 

WINDOWS 95, 98, ME, 2000, NT or XP 
- 100MHz Pentium processor 
- 32MB of RAM 
- 30MB free hard disk space 
- 800x600 screen resolution 
- ECP parallel port (IEEE 1284) for optimal 

data acquisition performance 
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1.1 Installation 
 
The GroundVision Software is delivered to you on an 
installation CD. It contains a set of program files that will be 
installed once you run the Setup.exe file. The latest version of 
GroundVision is always available to download from the web 
site http://www.malags.com/ 
 
When you double click on the setup file (either from the 
installation CD or from the downloaded file) you will enter an 
installation wizard that will guide you through the rest of the 
installation process. 
 
Note! If you are doing an upgrade installation of GroundVision 
it is recommended to uninstall the previous version of 
GroundVision first. This can be done easiest from the 
Windows Control Panel, Add/Remove programs.  
 

1.2 User interface 
 
The user interface of Ground Vision is following the standard 
of many other windows based programs. It supports multiple 
documents and multiple views of same document. Printing as 
well as window managing is quite similar and follow standard 
windows commands. 
 
 
 
 
 
 
 
 

www.malags.com 
7

http://www.malags.com/


ToolbarMenu 

Radargram 

Main Workspace 

Workspace Tabs Information menu 

 
Fig. 1.1 GroundVision main window with two separate files opened. 
 

1.2.1 Main Window 
This can also be called the application window. This window 
holds the application’s (GroundVision’s) menu, information 
menu, toolbar, workspace, and the radargram windows. The 
main window can be minimized, maximized, or resized to any 
size by the user. 
 

1.2.2 Workspace 
One can say that the workspace is the area managed by the 
user. The main window determines the size of the workspace. 
The user can manipulate the radargram and trace view 
windows size and position inside the workspace. As help there 

www.malags.com 
8



are workspace tabs, which keep track of the different windows 
and show which one is active. 
 

1.2.3 Menu 
The content of the menus varies depending on whether a file 
is open or not. All choices that are not available are gray.  
 

1.2.4 Toolbar 
The toolbar holds all the buttons. A toolbar button is a 
“shortcut” to a menu command, i.e. every button corresponds 
to a menu choice. If a button is grayed out that menu 
alternative is not available. Choosing Customize Toolbar 
under Options in the menu can customize the toolbar. 
 

1.2.5 Radargram 
The radargram is the image generated by the measured radar 
data. If the amount of data is larger than the window size, 
scrollbars are used to scroll the image, both horizontally and 
vertically. A mouse left click at a certain trace in the radargram 
shows that trace in the trace view. A mouse right click shows a 
popup menu containing the radargram specific commands. 
When the mouse pointer is moved across the radargram the 
information menu shows the actual trace number, sample 
number, depth/time and position/time. 
 

1.2.6 Trace View 
The trace view displays a trace, which is determined by the 
user. When scrolling the trace view the trace displays to the 
left in the radargram. The trace view is toggled On/Off from the 
keyboard with the T key. It can also be resized horizontally to 
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any size using the mouse. Choose Trace Window under 
Window in the menu and move the mouse, a left click 
determines the size. 
 

1.3 File format 
 
When measuring with Ground Vision two files are generated, 
one data file (.rd3) and one header file (.rad). The data file is a 
16-bit binary file and contains the sample values. The header 
file is a text file and contains measurement specific 
information. Never edit and save the information in the header 
file that can cause errors in the file information and give 
corrupt data. MALÅ GPR data files acquired from the DOS 
program GPR.EXE can also be plotted, filtered and printed 
with GroundVision. If files are to be copied to or from another 
computer or disc it is important that both the data file (.rd3) 
and the header file (.rad) are copied. 
 
GroundVision also generates other file types if save filter 
settings, palette, GPS and markers are enabled. A list of all file 
types follows: 
 
.RD3 16-bit binary data file 
.RAD Header information file 
.COR Coordinate file acquired from a GPS 
.MKN File with markers 1-9 with color codes and names 
.MRK Marker file generated by the X3MCorder 
.FIL Saved filter parameters 
.PAL Saved palette settings 
.MCH Multi Channel information file 
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2 Quick start 
_________________________________________________ 
 
This chapter deals with the most essential steps for making, 
viewing, and printing a radar image. Follow the five quick 
steps below and most of the basic functionality of 
GroundVision is covered. More detailed descriptions can be 
found in Chapter 3. 

2.1 Power ON 
 
First, make sure that 
the hardware is 
connected correctly 
and power is on. The c
bar of GroundVision shall be red to indicate a correct power
and working communication with the control unit (or 
X3M/X3MCorder). If the circle is not red, press the auto-dete
key in the toolbar F9, the circle shall become red within 5 
seconds otherwise either of an ECP communication failure, 
incorrect cable connections or power failure has occurre
 

ircle of the Start F5 button in the tool 
 on 

ct 

d. 

2.2 New measurement 

 order to make a new single channel measurement chose 

nder File 

. In the 

 
In
New Single channel 
measurement u
in the menu (Ctrl N) or 
the Start F5 key
“New Profile” dialog 
following specify the 
desired filename, 
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directory, antenna and trigger (See also detailed information
chapter 3). Press Start Measurement (Ctrl M) and the 
measurement begin.  
 

 in 

top the measurement by clicking the Stop (F6) button in the 

 to 

2.3 View a measured file 

o open a file, choose 

r. 

 
 

 to 

hen a file is opened the horizontal scrolling position is zero, 

 first 

 the 

2.4 Apply filters 

tart by choosing Filter under Radargram in the menu or right 
click in the radargram and choose Filter or press the F key. 

S
toolbar or choose Stop under Measurement in the menu. 
When a measurement is stopped the radargram is scrolled
display the beginning of the file. 
 

 
T
Open (Ctrl O) under 
File in the menu or 
click the Open file 
button in the toolba
This displays an 
ordinary Windows
"open file dialog" in
which the user 
specifies the file
open. 
 
W
i.e. the first trace are shown to the left in the radargram. 
Likewise the vertical scrolling position is also zero, i.e. the
samples are shown in the top of the radargram. Use the 
windows scrollbars or the arrow keys to navigate through
radargram. 

 
S
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This activates the “Filter Manager”. To the left, there is a list of 
available filters and to the right the list of the applied filters is
shown. 
 
The func

 

tionality of the Filter Manager is quite straightforward. 
hoose a filter and click 

 

d. By 

ltered without removing and applying. The 
o use are DC Filter and Time Gain Filter. 

om the Radargram 
enu. This command is also activated with the shortcut key 

utomatically. 

palette 

 Radargram in the menu or 
choose Palette in the popup 

enu or press the P key. This activates the “Palette Manager”. 

C
either the Add or the 
Remove button and the
chosen filter will be 
either removed or 
applied. It is also 
possible to double click 
the filter to be adde
“drag and drop” the 
order of the filters in the 
Applied list can be a
most common filters t
 
There is an option to disable all filters. This is done by 
selecting the Disable Filters command fr
m
Ctrl F. 
 
Note! On start-up, GroundVision loads the previous applied 
filters a
 

2.5 Change the 
 
Start by choosing Palette under
right click in the radargram and 
m
The palette has 30 colors and three levels of resolution. 
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Double clicking on a specific "color box" opens a Windows 
color dialog and a new color can be chosen. 
 
One single click on a color box makes it activate for 
interpolating colors. Another single click on the same color box 
eactivates it. When interpolating the palette it’s recalculated 

 closes 

sed 
atically. 

argram click on the Print button in the toolbar or 
n the File menu. A standard Windows print dialog 

ill appear in which the printer to use and pages can be 

 can 
 

ile 

 

d
depending on the colors in the active color boxes. OK
the “Palette Manager” and applies the palette to the 
radargram. 
 
Note! On start-up, GroundVision loads the previous u
palette autom
 

2.6 Print 
 
To print a rad
chose Print i
w
altered. The default settings are the same as the default print 
settings for your Windows operating system. Clicking OK 
prints the radargram with the actual settings. The printout
also be inspected prior to printout with the Print Preview in the
File menu. A Print Setup function is also available in the F
menu. A standard Windows print setup dialog will appear in 
which the printer, paper, and format can be altered. 
 
Note! A windows printer driver must be installed for the Print
Preview function to work. 
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3 Detailed instructions 
_________________________________________________ 
 

3.1 Files and radargrams 
 
The technique used when managing the files and the 
radargrams in Ground Vision is very similar to any other 
Windows program. Every radargram opens in its own window, 
which the user can maximize, minimize, and resize using the 
standard Windows commands. No data is changed in the data 
file (.rd3) when the file is open for viewing. By this reason 
there is no need for saving when the file is closed.  
 

3.1.1 View several files at the same time 
Viewing several files at the same time is simple. Just open the 
files separately and Ground Vision will keep track of which file 
corresponds to which radargram. In the bottom of the main 
window there are tabs showing which radargram is active (the 
one that is protruded). 
 
Each radargram has its own palette, scale settings, and filter 
list. If the user wants to change these setting for a specified 
radargram it must first be activated. 
 

3.1.2 Manage multiple views of same file 
To create a second radargram for a file already opened chose 
New Window under Window in the menu. Ground Vision treats 
these windows as if they were individual files and the user can 
manage them accordingly. 
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3.1.3 Handle the trace window 
In all radargram windows, there is a so-called Trace Window 
that shows a single trace. By clicking on the radargram the 
user determines which trace to be shown. Toggle (turn on/off) 
the trace window by pressing T on the keyboard. The trace 
window can also be activated either from the View menu or 
the Window menu. By doing this, the size (width) of the 
window is set by moving the mouse pointer and activated with 
the left mouse key. 
 

3.2 Measuring issues 
 

3.2.1 Change the measurement settings 
In order to view or 
change the 
measurement 
settings, click the 
Settings button in 
the “New Profile” 
dialog. 
 
All measurement 
specific settings can b
“Measurement settings” dialog. The trace view displays a tr
measured with the actual parameters and is updated for ev
change. All controls can be managed both with the keyb
and the mouse. 
 

e viewed and manipulated in the 
ace 
ery 

oard 

djusting the Sampling Frequency and/or the Number of A
Samples controls the Time Window. 
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Sampling Frequency 

0 times the 

ctly 

umber of Samples shall 

 

d  

lter the Trig Interval if the default settings are not 
tion on 

 

he Auto stacking option is enabled by checking the Auto 

atic 

se if 

shall be set to 
approximately 1
antenna frequency. If the 
trace view only displays a 
straight line, make sure 
that the transmitter is 
turned on and is corre
connected. Does not that 
help, try the Search for 
Time Zero button. 
 
N
be set to a value near 500 
for the best performance. A
higher number increase 
the total measured time win
speed and creates larger data files.  
 

ow but slow down the measuring

A
appropriate (see also Chapter 3.7.1 for more informa
encoders). Make sure that the Antenna Separation is correct.
Otherwise, the calculation of the zero for the vertical scale will 
be incorrect. 
 
T
check box to the left of the Number of stacks slider in the 
Measurement settings dialog (see figure 2.3). When autom
stacking is enabled then the radar system automatically 
performs as many stacks as possible for each trace. In 
practice this means that the number of stacks will decrea
the antenna is moved faster, and increase if the antenna is 
moved slower.  
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3.2.2 Edit the measurement information 

r 

s allow 
ping/editing. When 

ew inf

ditor! The file might be corrupted. 

he information on the 
efault printer with the printer default settings. How to change 

.2.3 Define, save, and delete antenna settings 

 be 
d. 

rwrite, New, and Delete) and 
K button. The new settings are now either saved or 

eleted in the control unit memory. 

There are two ways to 
bring up the Measurement 
Information dialog. Eithe
when a new measurement 
is started or by selecting 
Measurement Info under 
View in the menu. 
 
Only the white area
ty
desired editing has been 
made OK saves the n
 
Note! Never open the header file in any word processor or 

ormation in the header file (.rad). 

e
 
Clicking the Print Info button prints t
d
the printer and its settings is described in below.  
 

3
In the parameter dialog there is a 
Save button which leads to the Save 
Settings dialog. It is through this 
dialog the antenna parameters can 
be overwritten, new antennas can
defined, and antennas can be delete
 
Choose the desired option (Ove
click the O
d
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3.2.4 Continue with an existing measurement 
First, check that the control unit and the antenna is correctly 
connected and switched on. Then open the file to be 

y 

ever, the filter 
anager is not accessible during measurement. In order to 

lied filters the 

t (F5-key). 

ow filtered and the 
ring measurement will be filtered before 

kload 

ted to the power of the PC. When the 
ower of the PC is the limiting factor, vertical fields without 

 use it during 
easurement. However, the palette cannot be altered when 

continued and start the measurement. When the 
measurement is started, the radargram is automaticall
continued where the previous data was ended. 
 

3.2.5 Apply filters during measurement 
ilters can be applied during measurement. HowF

m
add or remove filters or alter the settings of app
user must do the following: 
 
1. Stop the measurement (F6-key). 
2. Apply filters  
3. Restart the measuremen
 
The data shown in the radargram is n
incoming data du
shown on the display. 
 
Note that filtering during measurement increases the wor
on the PC. The acquisition speed while heavy filtering is 
applied is much correla
p
data may occur in the radargram.  
 
Note! Applied filters only affects the view on the display, the 
raw data is always kept unaffected. 
 

3.2.6 Change the palette when measuring 
he user can define any palette andT

m
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measuring. If the palette is to be changed or altered when 
ers. 

roundVision supports logging of GPS data during 
measurement. The result of such a measurement is a GPS log 

, see File Format below) in which GPS 
e number. 

to 

he advanced options 

n to activate the communication with the GPS 
 is no contact make sure that the 

ettings (see below) match those of the GPS 

often several traces with exactly the same position in 

measuring the procedure is the same as for the filt
 

3.2.7 GPS Support  
G

file (*.cor, *.wsk or *.utm
data are written together with the corresponding trac
GroundVision can read GPS data from any GPS receiver that 
supports output of data with the NMEA or TSIP 
communication protocols. The GPS receiver should be 
connected to the serial port of the laptop. In order to make the 
GPS Manager visible chose GPS under View in the main 
menu. This menu alternative toggles the GPS Manager 
On/Off. 
 
When first shown the GPS manager window gives access 
basic options only. To 
ccess ta

just press the Advanced 
button. Pressing it again will 
close the Advanced section 
of the dialog.  
 
Basic options 
Connect to GPS 

ress this buttoP
receiver. If there
communications s
receiver. 
 
Interpolate positions 
Due to the low position update rate of many GPS receivers 

ere are th
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the GPS data file created by GroundVision. When the 

radar 

een the four different 
osition output formats supported by GroundVision: 

dard (*.cor), WSKTRANS (*.fri), UTM 

 which 
ed 

ns are all communications settings. 
ormally the default settings should work but if there is no 

 receiver use these options to make sure 
iver. 

atch those of the GPS receiver. 

l port on the computer to 
se for the GPS receiver. The default selection is the first 

COM 1). 

nication protocol to use. NMEA (0183) is 
 standard protocol that should work with most GPS receivers. 

rotocol supported by Trimble GPS units. The 
default selection is NMEA. 

Interpolate positions checkbox is checked this staircased 
appearance is removed by interpolating between positions in 
the data file. This procedure will give best results if the 
unit is moved with constant velocity.  
 
Output file format 
Use this selection box to choose betw
p
GroundVision Stan
coordinates (*.utm) and Local coordinates (*.lcf).  
The option Local coordinates supports GPS systems
directly can send transformed coordinates (with an extend
NMEA-protocol).   
 
Advanced options 
The advanced optio
N
contact with the GPS
that the communications settings match those of the rece
 
Baud rate, Parity, Data bits, and Stop bits  
These are serial port communication settings, which must 
m
 
Com. Port 
This setting determines witch seria
u
serial port (
 
Protocol  
Selects witch commu
a
TSIP is a p
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Output file formats 
When a new measurement is started a GPS data file is 
created in the same directory as the files containing GPR data. 

he file name of the GPS data file is the same as for the GPR 
le extension. During measurement the 

oss in 

ove mean sea 
vel, and HDOP. HDOP is a theoretical measure of the 

l coordinates based on the positions 

e 
te 

6  

6  

ransformation software made by “Statens kartverk 
 Norway”. The first line is a header required by WSKTRANS. 

t is defined s:a 

T
data with a different fi
GPS data file is continuously updated to minimize data l
occasion of a crash. When measuring multiple channels one 
GPS data file is created for each channel. 
 
GroundVision Standard 
This data file format contains the following information: trace 
number, date, latitude, longitude, height ab
le
accuracy in the horizonta
of the available GPS satellites. A lower value indicates better 
accuracy. The date and time is expressed in Greenwich tim
zone. The following is an excerpt of a *.cor file (Trace# da
time latitude N longitude E “height above MSL” M  HDOP): 
 
105  2000-9-13  11:9:33  65.18164955141  N  18.75051193218  W  357.2
M  1.454542 
106  2000-9-13  11:9:34  65.18164955141  N  18.75051193218  W  357.2

  1.454657 M
107  2000-9-13  11:9:35  65.18164955141  N  18.75051193218  W  357.26  
M  1.454898 
 
WSKTRANS 
This is a special data format suited for the WSKTRANS 
coordinate t
in
The file forma
 
EU89-Geodetisk,P,G,HE 
“Trace #” latitude longitude “height above ellipsoid” 
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UTM-coordinates 
This file format contains coordinates in the global UTM 
ystem. The coordinates are calculated from the GPS data 

ormulas on the WGS84 ellipsoid. The file 

roundVision supports a multiple marker function during 
measurement. Up to 9 markers of different type and color can 

e marker dialog.  

n 

 
 

 .MKN is generated if any 
asurement. The marker file 

in information about the 

s
using Redfearn’s f
format is defined  as: 
 
“Trace #”   northing   easting   “height above MSL”  “UTM zone” 
 

3.2.8 Markers  
G

be configured in th
 
The Markers configuration dialog is 
opened from the options pull-down 

enu in the main window. All the m
boxes in this window will be empty 
the first time GroundVision is 
started. The 9 numerical keys 1-9 o
the keyboard are predefined as 
marker keys. Each key needs to be
enabled by checking the white box
to the right of each key number. A 
new color can be selected by a 
double click on the color box. Any 
comment for each marker type can 
be entered in the comments field. 
 
A new marker file with the extension
marker keys are pressed during me

 a text file. The first 9 lines contais
marker settings. Following in the file there is 2 columns with 
trace number and marker type for all the markers from the 
measurement. 
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3.3 Filtering 
 
To be able to apply filters at least one file must be open. The 

re only valid for the active radargram. Much 
y described in the topics below is for mouse 

sage. However, the keyboard can be used in many of these 

sing Filter under Radargram in the menu or right 
lick in the radargram 

 
ht; 

 Filter Manager is quite straightforward. 
lick either the Apply or the Remove button 

 filter will be either removed or applied. You 
an also apply a filter by pressing the A or space key and 

be 

filter commands a
of the functionalit
u
cases. Use the Tab on the keyboard to move the input focus 
between functions and press the Spacebar instead of clicking 
the mouse. 
 

3.3.1 Apply and remove filters 
tart by chooS

c
and choose Filter in the 
popup menu. This 
activates the Filter 
Manager. To the left, 
there is a list of available
filters and to the rig
there is a list of the 
applied filters. 
 
The functionality of the
Choose a filter and c
and the chosen
c
remove a filter by pressing the R or delete keys, or you can 
both apply and remove by holding down the mouse button and 
dragging the filter to the list of available filters. By “drag and 
drop function” the order of the filters in the Applied list can 
altered without removing and applying. 
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When a filter is being applied, a filter-settings dialog appears. 
Each type of filter has its own 
settings dialog with the 

 It 

 

 in the
s dialog where the filter parameters can be 

ltered. There is an option to disable all filters. To do this 
the 

hat filter to use 
here is no simple answer to that question. A filter very useful 

 radar image a range of 

on 

To be able to view, alter, load, and save the palette at least 
one file must be open. The palette commands are only valid 

specific parameters. The 
trace window is common to 
all filter settings dialogs.
displays the trace chosen 
with the Trace Control with 
filters applied, including the
previous filters from the 
applied list. 
 
Double clicking on a filter
filter's setting

 applied list brings up the 

a
select Disable Filters from the Radargram menu or press 
shortcut Ctrl+F.  
 

3.3.2 Decide w
T
for some applications can be useless in others. Depending on 
the application and the quality of the
different filters can be applied. The knowledge and experience 
of the user often determines the time it takes to produce a 
useful image. A general recommendation is to start with DC 
Filter and Time Gain Filter, after that perhaps a frequency filter 
or background removal filter is needed. A detailed descripti
of the filters is found in Appendix 1. 
 

3.4 Palette issues 
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for the active radargram. 
e topics below is for mo

Much of the functionality described in 
use usage. However, the keyboard 

s 

or 

Palette Manager. The palette has 30 
lution. 

 
 

e 
hen 

 i our 
er

 Choose directory in which 
OK 

button. The palette will now be saved in the specified directory 
with the file extension ".pal". 

th
can be used in many of these cases. Use the Tab on the 
keyboard to move the input focus between functions and pres
the Spacebar instead of clicking the mouse. On start-up 
Ground Vision always defaults to the last used palette. 
 

3.4.1 Change the palette 
Start by choosing Palette under Radargram in the menu 
ght click in the radargram and choose Palette in the popup ri

menu. This activates the 
colors and three levels of reso
 
Double clicking on a specific "colour 
box" opens a Windows color dialog 
and a new color can be chosen. 
 
One single click on a "color box" 
makes it activated, which means that
it will be used when interpolating the

alette. Another single click on thp
same "color box" deactivates it. W
interpolating the palette is 
recalculated depending on the colours
boxes". OK closes the Palette Manag
palette to the radargram. 
 

3.4.2 Save a palette 
To save a palette click the Save Palette button and a standard 

indows save dialog will appear.

n the activated "col
 and applies the new 

W
the palette is to be saved, type in a file name, and click the 
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3.4.3 Load a palette 
To open a saved palette click the Open Palette button and a 
standard Windows open dialog will appear. Select the palette
file to be opened and click the OK button. The palette is now 
loaded into the Palette Manager. 
 

 

ity described in the topics 
elow is for mouse usage. However, the keyboard can be 

f these cases. Use the Tab on the keyboard to 
focus between functions and press the 

pacebar instead of clicking the mouse. 

ialog. This dialog is 
divided into four 

all 

ck
r ca
kin

3.5 Scales 
 
To be able to view and alter the scale settings at least one file 
must be open. The scale settings are only valid for the active 
radargram. Much of the functional
b
used in many o
move the input 
S
 

3.5.1 Show or hide scales 
Start by choosing Scales under Radargram in the menu or 
right click in the radargram and choose Scales in the popup 
menu. This activates 
the Scale Settings 

ed if the scale is shown in the 
n show (or hide) all the scales by 
g) these checkboxes. 

d

groups of controls, 
one for each scale 
(Left, Right, Upper, 
and Lower). In the 
upper left corner in 
the groups, there is a 
check box that is che
radargram. The use
checking (or unchec
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Once the settings are satisfactory click the OK button and 
radargram will display the new scales.  

3.5.2 Alter length scale settings 
gs 

r and lower length 

th scales are altered. 

ight scale settings. 

 red marker is shown in 

. 
g the Ground Velocity, which is to 

e entered as m/μs. 

ajor tick. 

 means that the 
 medium a certain 

 this 

The two groups of controls at the bottom of the Scale Settin
dialog are the ones containing the uppe
scale settings. By manipulating the values for the major and 
minor ticks the appearance of the leng
The labels are shown for every major tick. 

3.5.3 Alter depth scale settings 
The two groups of controls at the top of the Scale Settings 
dialog are the ones containing the left and r
The First Arrival value is used to calculate the scale zero (see 
3.5.4) and is in number of samples. A
the scale at the first arrival. 
 
The scale can either show the depth or the time, altered by 
clicking the Time or Depth buttons in the Scale Settings dialog
The depth is calculated usin
b
 
By manipulating the values for the major and minor ticks the 
appearance of the depth/time scales are altered. The labels 
are shown for every m

3.5.4 Adjust for first arrival travel time 
Due to antenna separation, the wave traveling from the 
transmitter directly to the receiver (the direct wave) is received 
some time after the actual transmission. This
transmitted pulse has already penetrated the
distance before the direct wave is received. The result of
is that the depth scale zero must be corrected to be accurate.  
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The zero for the depth scale is calculated using the first arrival 
value, the antenna separation, and the first arrival adjustment 
velocity. The adjustment velocity can be set to any value. 
Practically however, it can be the ground velocity, the air 

.6.1 Print a radargram 
ram click on the Print button in the toolbar or 
e menu. A standard Windows print dialog will 

 use and pages can be altered. 
ame as the default print settings 

o 
g job it can be done in the 

ear when printing (see 3.6.1). If 
argrams on a printer other than 

r, paper, and format can 
ettings default for future 

t 

velocity, or anything in between depending on the antenna 
configuration. 
 

3.6 Printing 

3
To print a radarg
chose Print in Fil
appear in which the printer to
The default settings are the s
for your Windows operating system. Clicking OK prints the 
radargram with the actual settings. 

3.6.2 Choose the printer 
There are two ways of changing the printer. If the printer is t
be changed just for the actual printin
Windows print dialog that app
one wants to print several rad
the default, that printer can be chosen as default (see 3.6.3). 

3.6.3 Alter the printer settings 
To alter the default printer settings in Ground Vision chose 
Print Setup in the File menu. A standard Windows print setup 
dialog will appear in which the printe
be altered. Clicking OK makes the s
print jobs. Note that these settings are not saved and will no
be the same if restarting Ground Vision. 
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3.6.4 Use the print preview 
The print preview functionality is similar to Microsoft Word. 

enu and the radargram will 
inted. The print preview uses 

e 

alibration 
ncoder 

the 

ol unit 
itch the 

ontrol unit on. Choose New Wheel 

alog (th
e calibration is started). Type 

e desired name of the calibration in the Name edit box. OK 

Chose Print Preview in the File m
be displayed as if it were to be pr
the default printer settings. To change the appearance of th
radargram in the print preview mode, change the default 
printer settings (see 3.6.3). When done viewing the radargram 
in print preview mode, click on the Close button. 
 

3.7 System settings 

3.7.1 Perform a wheel c
Note! The precision of the e
wheel is not infinite and depending 
on several factors as; the 
measurement surface, the pressure 
applied on the wheel and possible 
wear. If you are unsure of 
encoder wheel precision a re-
calibration should be made. 
 
Start with connecting the contr
and the wheel to calibrate, sw
c
Calibration under Options in the 
menu and the New Wheel 
Calibration dialog will appear,  
 
Follow the instructions in the di
turn into a STOP button when th

e START button will 

th
saves the new wheel calibration in the control unit memory. 
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3.7.2 Delete an old wheel calibration 
Start with connecting the control unit and switch it on. Choose 

 the menu and the 
ialog contains a list 

ton. 
ves the calibration from the control unit memory. 

ote that there is no Undo command. Once deleted it is gone. 

utton t

as 

ettings with two checkbox. 
st is for enable or disable the audio device on the CUII 

 the control unit will give an 

                                                

Remove Wheel Calibration under Options in
remove calibration dialog will appear. The d
of the entire wheel calibrations saved in the control unit 
memory. 
 
To delete a calibration, mark it and click the Remove but
This remo
N

3.7.3 Choose Measurement Units 
Choose Measurement Units under 
Options and the Measurement Units 
dialog will appear. Select the unit you 
wish to use and then press the OK b

3.7.4 Change Control Unit Setup 
The Control Unit Setup dialog is 

o confirm. 

divided into three areas. The first 
area shows the current version of 
the control unit PROM. If the 
control unit is disabled or 
communication doesn’t work, the 
PROM version will be shown 
N/A1. 
 
The second area is for general s
The fir

 

or the X3MCorder. If it is enabled,
audio signal at each measured trace. 
 

 
1 This will also happen if another port protocol than ECP is used with PROM versions prior to 
104 

www.malags.com 
31



The second checkbox enables or disables a kill switch function
when using the High Frequency anten

 
nas (1.2 and 1.6 GHz, 

S models only). If it is enabled measurements can only be 

d 

nd 
e control unit. As default, automatic detection of port and 

on 
n 

cation 

l. 

e 
y 

re 

figuration is usually changed in 
e computers BIOS settings; the manual for your computer 

ee the 

U
carried out if the kill switch button on the antenna is pressed 
down. The measurements will continue for 8 seconds when 
the button is released, and the stop. More information is foun
in the Operating Manual for the High frequency antennas.  
 
The third group in the Control Unit Setup is the communication 
settings how communication is performed between the PC a
th
protocol settings is enabled. This means that when the 
program is started, the PC will try to detect the best settings 
for this computer. By disabling automatic detection, the 
application can be forced to skip the detection phase up
startup and instead use settings selected by the user. This ca
be useful if the settings are already known or if the appli
has problem with automatic detection. If the automatic 
detection is disabled, the settings should be set to match the 
current port configuration, which can be found by examining 
the information available in the computer’s control pane
Please note that some of the settings will be disabled 
depending on the system; for instance, under Windows NT th
IRQ setting is disabled since this information is provided b
the system. At present, two communication protocols a
available: SPP 2 and ECP.  
 
To get highest performance the parallel port should be 
configured as ECP. Port con
th
will tell you how to do this. For further information also s
Parallel port configuration guide of this manual. 
 

                                                 
2 Known also as standard, simple or compatible mode. 
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4 Multi channel measurements 
_________________________________________________ 
 

4.1 New measurement 
Compared with single channel measurements, the biggest 
difference in GroundVision when you are doing Multi channel 
measurements is the 
dialog you will 
encounter when 
choosing a New Multi 
channel measurement 
(F8). Filename, 
directory, trigger and 
trigger source are 
chosen the same way 
as when doing a single 
channel measurement. 
The user decides the 
number of data 
channels in the 
“Number Of Channels” 
box, (1-16). For every 
channel a new flap that contains the settings for each channel 
is shown. Antenna, Settings and Info works as in the single 
mode. 
 
The user has to define the transmitter and receiver for each 
antenna. All 4 transmitters and receivers are shown even if all 
data channels are not chosen. The settings parameters can be 
set individual in each of the new channels. When pressing OK 
a new radargram is for each of the channels is shown. To start 
the multi channel measurement press the “REC-button” (F5) 

www.malags.com 
33



or choose Rec in the Measure menu. This gives you the 
art. (After the 

 MC 

 

el
ion for 

a

e

 
1_1.rd3

er can open a Multi channel measurement by choosing 

possibility to arrange the windows before you st
measurement is started the windows are locked in position.) 
 

4.2 Files associated with
 
When performing a Multi channel measurement GroundVision
creates a data file (.rd3) and a header file (.rad) for each 
channel. A Multi chann
common informat
The mch- file gets the n
Multi channel measurem
the same name plus a p
affiliated channel  
 
Example: The user writ
of channels is 3.  
The following files are th
 

• MCProfile1.mch
• MCProfile
• MCProfile1_2.rd3
• MCProfile1_3.rd3

 
*.cor and *.mrk files separate for every channel 
 

he us

 file (.mch), which contains the 
the measurement, is also created. 
me that the user writes in the “New 
ent” dialog. The .rd3 and .rad files get 
refix (a number) that reflects the 

s filename MCprofil11 and the number 

en generated: 

 , MCProfile1_1.rad 
 , MCProfile1_2.rad 
, MCProfile1_3.rad 

T
File type “GV MC files” in the menu “File open”. If a Multi 
channel file is opened a radargram for each channel is 
created. The Multi channel –info, -data and -header file must 
all been saved in the same folder.   
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5 Parallel Port Configuration Guide 
_________________________________________________

 
 

cation to your 
omputer, you should first make sure that your system is 

led 
g 

te that at some point you may be asked to 
put your Windows installation CD-ROM; before you begin, 

.1 Check BIOS settings 

p; for information 
r’s 

g port settings; on 
. Make 

though not 

 
Before installing the GroundVision appli
c
configured correctly. To do this, it is advised that you follow 
the procedure described below. If you already have instal
the application but find that data acquisition is not workin
properly, you should also follow this guideline.  
 
Note! You must have administrative privileges on your 
computer to be able to perform some of the described 
operations. Also no
in
you should first locate it. 
 

5
 
Start your computer and enter the BIOS setu
on how to do this on your system, consult your compute
r
m
eference manual. Find the section containin
ost systems this is found under Peripheral Devices

sure that the parallel port is set to ECP mode. Al
necessary, if the BIOS allow changing the port address and 
IRQ for the port it is recommended that one of the following 
configurations are used: 
  
Table 2-1. Recommended port settings 

Port Address Interrupt Request (IRQ) 
0x0378 7 
0x0278 5 
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5.2 Check port type  
 

3

 
he device manager can be found as follows:  

 up 
e 

.2.2 Windows 2000 and XP 
en up 

re tab 
nd then press the Device 

ouble-click on Ports (COM & 

l, run Add New Hardware. The 
arch report that it 

P printer por xt to 
d.  

                                                

Now, you should start Windows and open the device manager.
T

5.2.1 Windows 9x and Me 
Select Settings -> Control Panel in the Start menu to open
the control panel. Then, double-click on the System icon in th
control panel to open the system properties dialog. In the 
dialog, select the Device Manager tab. 

5
Select Settings -> Control Panel in the Start menu to op
the control panel. Then, open the system properties dialog by 
double-clicking on the System 
icon in the control panel. In the 

ialog, select the Hardwad
a
Manager button. 
 
D
LPT); under this branch you 
should now see an entry marked 
ECP Printer Port. 
 
If there is no such node, your 
system is not aware of the parallel port. In this case, you 
should perform the following steps:  
 

 

1. In the control pane
computer should after an initial se
found an EC t; if it doesn’t, press Ne
procee

 
3 This step doesn’t need to be performed for Windows NT 
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2. When asked if Window
hardware, you should select 

s should search for the new 
No and then press Next to 

T) and press 

drivers for the COM and LPT 

er 
ger. If you see a node 

found the port but 
d (non-ECP) parallel port. 

r 
 di

 and th
tton. You should e 

drivers for the port. 
and

u
you can later 

evice manager. 

 

o 

proceed. 
3. You will now be presented to a list of available 

hardware types; select Ports (COM & LP
Next to proceed. 

4. A list will show available 
ports. Select ECP Printer Port and then press Next.  

 
The system will now install the selected driver; you can lat
verify this by looking in the device mana
but it is marked Printer Port, the system has 
incorrectly identified it as a standar
In this case you should try to change the driver by performing 
the following steps: 
  

1. Double-click on the Printe
the printer port properties

2. Select the Driver tab
Driver… bu

Port node; this will open up 
alog.  
en press the Update 
 now see a list of alternativ

 then press OK.  

rrent driver with the ECP 
verify this by looking in the 

3. Select ECP Printer Port 
 

The system will now replace the c
printer port driver; 
d
 

5.3 Check port configuration1

 
Now we are ready to check the configuration for the port. T
do this, enter the device manager and double-click on ECP 
Printer Port to open the printer port properties dialog.  
 

www.malags.com 
37



To view the port configuration, click on the Resources tab. 
should now be able to read the port settings. If the current 
resource settings don’t include an interrupt request, you 

You 

ilable in 

settings to be able to perform 

hould try 
 resolve the reported 

 the settings for 
rt in 

1 This step doesn’t need to be performed for Windows NT 

e port work as 
xpected under Windows 2000 and XP, 

. 

gacy Plug and Play detection check box. 
 

should try to select one of the other configurations ava
the configuration drop down 
list. If you are using Window 
9x/Me, you will first have to 
disable Use automatic 

this operation. Make sure that 
the selected configuration 
matches your BIOS settings. 
Verify that the conflicting 
device list shows no conflicts. 
If it does, then you s
to
conflicts either by changing 
the resources for this port or by changing
another device. If you have to change the IRQ for the po
order to avoid conflicts, you should do this in your BIOS; see 
the first step in this guideline. 
 

5.3.1 Windows 2000 and XP specific issues 
In order to make th
e
some additional steps have to be 
performed. Click on the Port Settings tab
 
As filter resource method, you should 
select Use any interrupt assigned to the 
port. You should also check the Enable 
le
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5.4 Install software 
 
When the steps above have been performed, it’s finally time to 
install the software; to do this, just run the setup.exe for the 
installation and follow the onli

5.4.1 Windows 2000 and
If the software was installed be
configurations, then you should
Information Update, which 
MALÅ Geoscience -> GroundV
should then restart the com
 

ne directions.  

 XP specific issues 
fore changing the port 
 at this stage run Parallel Port 

is located in the Start menu under 
ision. After doing this, you 

puter before running GroundVision.  
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6 Trouble shootin
_____________________

g 
____________________________ 

- The port doesn’t support interrupts    
 

6.1.1.1 Solution 
Step 1 
Check connections and verify that the control unit is switched 
on and working properly. You should also check that the 
parallel port is properly identified by the operative system and 
not conflicting with another device; for information on how to 
do this, read your Windows manual. 
 
Step 2 
Start GroundVision and select Control Unit Setup in the 
Options  menu. Enable automatic detection or set 
communications to match the settings found in the control 
panel and then restart the computer. 
 
Step 3 
If communications still isn’t working, check the parallel port’s 
BIOS settings; the parallel port should be set to use either 

 

6.1 Communication 

6.1.1 Communication isn’t working 
Possible causes: 

- Invalid BIOS settings 
- Invalid communication settings 
- Another device driver blocks access to 

the port 
- Hardware problems 
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SPP (compatible) or ECP mode4. It is also recommended that 
ress 0x0378, IRQ 7.  

e identified as an ECP printer port in the device manager. If 

mputer restarted; the operating 

 
Step 4 
By now, yo  and 
running; if t
another device g the port or using the port 
incorrectly.  CD-writer or a 
ZIP-driver o

ling or temporarily removing the driver for this device.  
 

 come this far and still haven’t got communications up 

 then 

rking in SPP mode  
heck the parallel port’s BIOS settings; the parallel port 

e set to use either SPP (compatible) or ECP5 mode. It 
ress 

en selected in BIOS and 
is is a Windows 95/98 system the parallel port should now 

ified as an ECP printer port in the device manager. If 

the port be set to use port add
After startup, if the ECP mode has been selected in BIOS and 
his is a Windows 95/98 system the parallel port should now t
b
this is not the case, the port should be removed from the 
device manager and the co
system should now identify the port as ECP and install the 
correct port driver. 

u should at least have SPP communication up
his isn’t the case, the most probable cause is that 

 driver is blockin
 If you use an external device like a
r if you have a hardware dongle, you should try 

disab

Step 5 
If you’ve
and running, you should try using another computer to verify 
that the control unit is working properly. If this is the case,
it is possible that the parallel port is faulty on your computer.   

6.1.2 Communication is only wo
C
should b
is also recommended that the port be set to use port add
0x0378, IRQ 7.  
 
After startup, if the ECP mode has be
th
be ident
                                                 
4 Control units with PROM versions prior to ver.104 only support communication through
5

 ECP. 
 Control units with PROM versions prior to ver.104 only support communication trough ECP. 
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this is not the case, the port should be removed from the 
device manager and the computer restarted; the operating 

the 

use 
n happen if another device driver is blocking or making 

to 

 using Windows NT, then you should try exiting and 

; 

ctly. If 

ving the driver for this device. 

system should now identify the port as ECP and install the 
correct port driver. 

6.1.3 The parallell port is configured for ECP, but 
application reports SPP  

6.1.3.1 Possible ca
This ca
improper use of the parallel port resources. Under Windows 
NT, it will also sometimes happen if the application is started 
when the control unit is disabled or disconnected. 

6.1.3.2 Solution 
First, make sure that you have not explicitly set the protocol 
SPP by selecting Control Unit Setup in the Options menu.  
If you’re
restarting the application with the control unit connected and 
active. If the program still reports SPP, the probable cause is 
interference from another driver. Otherwise, you should 
explicitly set the protocol to ECP in the Control Unit Setup 
dialog to make sure the right protocol is selected.6    
You should at least have SPP communication up and running
if this isn’t the case, the most probable cause is that another 
device driver is blocking the port or using the port incorre
you use an external device like a CD-writer or a ZIP-driver or if 
you have a hardware dongle, you should try disabling or 
temporarily remo
 
- "Communication with the control unit failed! Please 

check connections/ battery and retry." No 
communication with the control unit. 

                                                 
6 This is a known problem with the current NT driver. 
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- "No response from receiver. Please check power a
connections, then restart the control unit." 
Communication with the control unit but no response fro
the receiver. 

nd 

m 

 

6.2 EEPROM 

l 

d parameters to EEPROM. Please restart 
n and reset the control unit" GroundVision 

ndVision 

"The wheel calibration list is full! Remove wheel 

occur. Remove 
unused wheel calibration and try again. 

 

 
- "Unable to access the EEPROM! Please contact 

support." GroundVision can not access memory in contro
unit. Change battery and retry, if no change contact 
support. 

- "Unable to ad
Ground Visio
cannot access memory in control unit. Change battery and 
retry. 

- "Unable to delete settings from EEPROM. Please 
restart Ground Vision and reset the control unit" 
GroundVision can not access memory in control unit. 
Change battery and retry. 

- "Unable to write settings to EEPROM.Please restart 
Ground Vision and reset the control unit" Grou
cannot access memory in control unit. Change battery and 
retry. 

 

6.3 Wheel calibration 
 
- 

calibrations before adding another." The control unit 
memory is limited. If the area dedicated for wheel 
calibrations is full this error message 
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- "Wheel calibration distance is too short." In order to 
make a proper wheel calibration a quite large d
should be used. Redo the calibration over a longer 
distance. 

istance 

6.4 Multichannel 

Unrecoverable internal error in multi channel routine." 
t and 

sion 
ntact with the receiver specified for the channel in 

 

PR.EXE can still be displayed, filtered and printed in 
GroundVision. 

 

 
- 

Multi channel info is corrupt. Check “.mch” file, restar
try again. If the problem persists reinstall GroundVision. 

- "No response from channel number …" GroundVi
has no co
question. Check that the settings are proper, check 
batteries and connections and try again. 

 

6.5 File handling 
 
- "It is not possible to continue on a measurement 

performed with the DOS acquisition software" Due to
differences in file formats of measurements done with the 
DOS acquisition software (GPR.EXE), these files cannot 
be continued for measurement in GroundVision. All files 
from G
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7 List of key-words 
_________________________________________________ 

ample In order to collect and store GPR data the 
agnetic waveform has to be digitized. A 

 digital amplitude value of the waveform 
at a specific time.  

tacks The number of stacks is equal to the number of times 
that each sample is measured and averaged over. 

ansmitted energy that travels the 
shortest distance between the transmitter and 

own. 

Ground velocity The velocity (moving speed) of the electromagnetic 
wave in the ground. Different velocities are 
corresponding to different soil/ground types. 

 
Travel time The time elapsed between when the signal is 

transmitted and when it reaches the receiver. 

 
S

electrom
sample is the

 
Trace Several samples collected during a certain time 

interval generate a digitized image of the waveform, 
also known as a trace. 

 
Sampling freq.  The interval in which samples is taken over the trace 

length. A higher sampling frequency gives a shorter 
time window. 

 
S

 
Direct wave The part of the tr

receiver. 
  
First arrival  The user must set the first arrival value in order to 

show correct scaling. Normally it is set to the sample 
number that corresponds to the Direct Wave. 

 
Time window Defines the total trace length in time.  Can be 

recalculated to a depth value if the ground velocity is 
kn
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Appendix 1  
_________________________________________________ 
 

1.1 Available
This appendix covers the available filters in the Ground Vision 
lter manager. The filters that have settings that need to be set 

from the Filter 
anager and is 

description. Com
 all filter dialog

shows the filtere
ace. The trace 

when there is a c can 
eyboard.  

amplitude of the 
nown as the DC r the DC offset. 

 Th
individually calcu
ach trace. 

In the dialog (to t
interval on which the DC component is calculated is specified. 
The end sample is always the last sample in each trace and 

 filters 

fi
have a dialog connected to them. This dialog can be called 

M
shown in each filter 

mon 
s is to

the trace window that 
d 

tr
window is updated 

hange in the filter settings. The dialogs 
be handled with both mouse and k
 

 1.2 DC-Filter
There is often a constant offset in the 

registered trace, this is 
 level ok

This filter removes the DC component 
from the data. e DC component is 

lated and removed for 
e
 

he right) the sample 
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the start sample is set using the spin button. The sample 
s a re area at the bottom of the trace. The 

 

e is multiplied by a gain function 
 an 
 
 user. 

utton 

ts 
 
e 

e gain function applied. The red part of the 
ace window indicates the part of the trace that is filtered. The 

ltered by using the spin buttons or by 
m the keyboard.  

o available:  

interval is shown a d 
start position can also be selected by clicking in the trace 

indow with the mouse pointer.  w
 

1.3 Time-Gain Filter
The Time-Gain filter applies a time-varying gain to 
compensate for amplitude loss due to spreading and 
attenuation. The trac
combining linear and
exponential gain, with
coefficients set by the
It also has an Auto b
which when pressed 
calculates and sugges
filter coefficients. In the
Time-Gain dialog (to th
right), there is one trace 
window and one gain 
window. The trace window shows a filtered trace and the gain 

indow shows thw
tr
filter settings are a
entering a value fro
 
The following keyboard shortcuts are als

l – increase linear gain factor  
Control + l – decrease linear gain factor  
e – increase exponential gain factor  
Control + e – decrease linear gain factor 
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1.4 Running Average Filter 
The running average filter smoothes 
the radargram by replacing each 
sample with the mean value 
alculated from all samples in a c

window centered on the active 
ow (or 
xtreme 

raging mask. 

e a
t the c

n tra
ve 
zont
 by 

avera ace as the means of 
the w
Subtr e subtracted from the 
ata can be calculated in two different ways, either as the 
ean of the whole data set or as the mean over a window 

entred around the trace to be filtered. 

sample. The larger this wind
averaging mask) the more e
becomes the smoothing effect.  
 
Select the size of the ave
The numerical keys 3,5,7,9 a
mapped as shortcuts to th
will be updated to reflec
 

1.5 Subtract mea
This filter is used to remo
horizontal and nearly hori
features in the radargram
subtracting a calculated mean trace 
from all traces The running average 
version subtracts a mean trace 
calculated in a window centred at 
the trace to be filtered. The size of 
his window is selected by the 

nd 1 are 
vailable settings. The trace view 
hanges in the settings. 

ce 

al 

t
Number of traces to use in filter 
process edit box. The Total 

ge method calculates the means tr
hole data file.  
action method; the mean trace to b

d
m
c
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Number of traces to use determines the number of traces to 
ean trace to be 

 are av
 use in 

of traces

 
s 

th FIR 
 

rs are 

s 

I
ive filt

he h
out atten ff 

 

be averaged in the calculation of the m
subtracted.  
 
The following keyboard shortcuts

n – increase Number of traces to
control + n – decrease Number 

 

1.6 Band pass filter 

ailable: 
filter process  
 to use in filter process 

wanted frequencies Band pass filters are used to remove un
from the traces. Frequencies below 
the lower cut-off frequency and 
above the upper cut-off frequency 

re attenuated. a
 
The band pass filter dialog is used
to adjust the settings for band pas
filters applied to the data. Bo
(finite impulse response) and IIR
(infinite impulse response) filte
available. FIR-filters are slower but 
generally provide better results. The 
frequencies define the boundarie
filter.  
Filtering method selects between (F
filters are also known as recurs
Upper cut-off frequency defines t
passed through the filter with
frequency defines the lowest frequency.  
 

upper and lower cut-off 
of the pass-band of the 

R) and (IIR) filters. IIR 
ers.  
ighest frequency that is 
uation, and Lower cut-o

The following keyboard shortcuts are available: 
u – increase upper cut-off frequency 
control + u – decrease upper cut-off frequency 
l – increase lower cut-off frequency 
control + l – decrease lower cut-off frequency
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1.7 Background removal filter 
This filter removes horizontal features or 

lmost horizoa ntal features from the data 

simila
ean trace filter. Going from the Normal 

to the Extreme setting has the effect of 
re sloping 

 c
y y) 

ly. 

 c re 
 
 d

ter attempts to adjust the gain of 

ould cause all amplitudes to be equal. 
e same length 

as th ct on the trace. After 
equa  the trace to 
make

by applying a horizontal spatial high 
pass filter. The effect of the filter is 

r to that of the running subtract 
m

removing progressively mo
events.  
The three settings Normal, Strong and 
Extreme, corresponds to normalized
off frequencies (frequency divided b
of 0.01, 0.025 and 0.05, respective

ut-
the sampling frequenc

ompensated). Therefo
appearance of the 
uring viewing of 

 
Note that during measurement a less powerful filtering 
algorithm has to be used (not phase
there will be a slight difference in the
radargram during measurement and
recorded data. 
 

1.8 Automatic gain control 
This fil
each trace by equalizing the mean 
amplitudes observed in a sliding time 
window. A short window gives a more 
pronounced effect, the extreme of which 
would a one-sample window, which 
w
The other extreme would be a time window of th

e trace. This would have no effe
lization a constant multiplier is applied to
 the resulting amplitudes reasonable. 
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Appendix 2 
_________________________________
 

2.1 GPR, Principle 
 

Radar is, in principle, related to 
reflection seismic methods. A 

________________ 

 

 

transmitter (Tx) emits a signal into the 
surface of investigation. The back 
reflected signal is detected and 
registered by a receiver (Rx). In 
ontrast to seismic methods, radar c

instruments uses electromagnetic 
waves instead of acoustic waves. 

 
EM-waves will not penetrate as deep as acoustic wave
will result in muc

s but 
h higher resolution maps. Targets with a 

ontrast in electrical impedance to the surrounding media will 
re, surface radar 
tection and localization of 

o an approximate 

s signals into the 

c
be registered and detected. Therefo
instruments are primarily used for de
metallic and non-metallic targets down t
depth of 30 m. 

2.2 Measurement basics 
 
The MALÅ control unit continuously emit
media of investigation. The number of scans per length or time 
unit is set in the software. Normally, acquisition is performed in 
profiles on top of the surface of the media. Results of the 
survey can, instantaneously, be viewed on the laptop 
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computer controlling the measurement. Ground Vision allows 
uring measurement. 

s hyperbolas, whilst plane reflectors will maintain their natural 
al resolution of the results varies 
depending on the choice of antenna 

equency. Higher antenna frequency gives higher resolution, 
rsa. 

real time filtering d
 

oint reflectors will, due to spherical dispersion, be registered P
a
form. The lateral and vertic
between 0.01-1.0 meters, 
fr
but less penetration, and vice ve
 

Point reflector

Plane reflector

 

Surface

Hyperbolic reflection
from point reflector
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r  
cities for a number of 

edias. εr varies greatly with the water content in the medium. 
The larger value given for a velocity applies to a more 
unsaturated media. 
 

Medium εr Velocity [m/μs] 

Appendix 3 
_________________________________________________ 
 

3.1 Velocities in Certain Medias 
 
The following table gives approximate values for ε  (relative
ermittivity) and the resulting velop

m

Air 1 300 

Fresh water 81 33 
   

Limestone 7 - 16 75 - 113 

Granite 5 - 7 113 - 134 

Schist 5 - 15 77 - 134 

Concrete 4 - 10 95 - 150 
   

Clay 4 - 16 74 - 150 

Silt 9 - 23 63 - 100 

Sand 4 - 30 55 - 150 

Moraine 9 - 25 60 - 100 
   

Ice 3 - 4 150 - 173 

Permafrost 4 - 8 106 - 150 
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